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Q&A Executive Training
Conditional Hiding

Reports are designed for people to see things; but sometimes in the construction of
a report important columns or rows should not be shown; they hold elements that
are important for the calculation of the report, but that should not be present in the
final product. There are other times when that same element should be displayed.
Conditional Hiding based on Format Tables provide this flexibility.

Conditional Hiding lets us hide elements that make the report possible, but that
might be a distraction in the report at run time.

This lesson will use the Employee Expenses report to illustrate the steps.

File Edit View Insert Format Cell Mode Tools Window Help

DR - SH S0- 888 | © Y BRBRCE S | Tshome 975 - B IU [E=E=4-A-0 8% 5 W%,
Code Description Filter From Filter To

.................................................... i Worksheet | pocument

@ EMPLOYEEEXPENSES T
EmployeeExpenses {SheetTitle}
D21 ~ |
A B © D E F G H I
1 Ace Union
2 Analysis of Employee Expenses
3 2016 to 2017 Comparison
4
7 2016 2017
8 1811220 Car Depreciation Allowance 1.00 1.00 $0.00
9 |811230 Child Allowance 1.00 1.00 $0.00
10 |811410 Avrea Travel Subsidy (House to Office Travel) 1.00 1.00 $0.00
11 |816110 Medical Policy Premium 1.00 1.00 $0.00 e
12 (817110 Tax Assistance 1.00 1.00 $0.00
13
14 5.00 5.00

Cells E8 through E12 in this report hold auto formatting and there are messages in
cells F8 through F12. In this lesson, formatting commands will be added to hide
columns A and E, depending on the Accountant's or Controller's run time decisions.

Important: Remember formatting logic follows a top to bottom and left to right flow.
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File Edit View Insert Format Cell Mode Tools Window Help
DR - FH S0 - BHEE | §BRIES | Thom o5 - BIU|EZE=E2-A-B 8% 5 | 9%

Filter From

Worksheet | Document |

@ EMPLOYEEEXPENSES b

EmployeeExpenses {SheetTitle}
m o |
A B < D E F G H
Define Criteria hployee Expenses
[ Clear Contents ‘mpar-so"
4 Cell »
| 1% Undo | 2016 2017
| § &% cut Ctrl+X pn Allowance 1.00 1.00 $0.00
| $Ba Copy CtisC B 1.00 1.00 $0.00
| 1 B paste Ctrl+V psidy (House to Office Travel) 1.00 1.00 $0.00
1 | Premium 1.00 1.00 $0.00
i FormatCells b 1.00 1.00 $0.00
J| Insert b| Row |
| 1 Delete » Column 5.00 5.00
j Sheet Properties [ Worksheet
| 1B Criteria View Ctrl+Q Excel Worksheet |
| 1 Mode » |l Chart L N
- & Print Extend worksheet by a row |
12 Formula 3 Extend worksheet by a column
22 i R Page Break |
23 Clear Page Break
24 Name
25 E Picture
25, @ Attachment
27

e Select the top row of the spreadsheet — Al
e Right-click

e From the dropdown menu, select Insert

e Select Row

Remember the goal: Hide certain columns, rows, and cells under certain
circumstances.

In the new row, type ‘Yes' into cells Al, ET, F1,and I1.
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File Edit View Insert Format Cell Mode Tools Window Help
DR - FH S0 - BEE v~ $RRAIE S | Thm s - BIUE[EES A 8% 0 W

EmployeeExpenses {SheetTitle}
| 828 =l |
A 8 c D E F G | H 1

1 |Yes Yes Yes Yes
2 Ace Union
3 lysis of Employee Exp
4 2016 to 2017 C
5
8 2016 2017

| 9 /811220 Car Depreciation Allowance 1.00 1.00 $0.00 |

| 10 811230 Child Allowance 1.00 1.00 $0.00 | e}
11 |811410 Area Travel Subsidy (House to Office Travel) 1.00 1.00 $0.00
12 816110 Medical Policy Premi 1.00 1.00 $0.00
13 817110 Tax Assistance 1.00 1.00 $0.00
14
15 5.00 5.00

e Clickin cell B24
e Typeininstructions for the bookkeeper

o Run this report each month, changing the dates.
e TypeYesincell 24

File Edit View Insert Format Cell Mode Tools Window Help
DR - BH S0 - BEE |©~ ¥RRBIES | Thm 975 - BIUES=ES-AH 8% B

| Document |
{SheetTitle}
[ 124 | res
A B & D E F G H I
1 |Yes Yes Yes Yes
2 Ace Union
3 Analysis of Employee Exp
4 2016 to 2017 Comp
5)
8 2016 2017
9 811220 Car Depreciation Allowance 1.00 1.00 $0.00
| 10 1811230 Child Allowance | 1.00 1.00| $0.00
11 811410 Avrea Travel Subsidy (House to Office Travel) 1.00 1.00 $0.00
12 (816110 Medical Policy Premium 1.00 1.00 $0.00
13 817110 Tax Assistance 1.00 1.00 $0.00
14
15 5.00 5.00
17
18
19
| 20 |
21
22
23
| 24 | Run this report each month, changing the dates. | Yed

Why enter ‘Yes' into cells Al, E1, and F1?
e Because there are times when those columns should be hidden
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Why enter the message in cell B24?
e Because the person running the report needs to know what needs to be done

Why enter ‘Yes' in cells

Tand 1247

e Because it serves as a control for hiding rows 1 and 24
e Those rows will be hidden when the report is run, because the message and
all the ‘Yeses’ should not be displayed on the report

The report can also be formatted to differentiate between the report and the
engineering that makes it possible.

e Right-click in cel

e From the dropdown menu:

o Select For

[ Al

mat Cells

o Select Back Color

Worksheet I Document I

o Select Grey

{SheetTitle}
IAl Z| |Yes
= = D E F G H I
1 Define Criteria Yes Yes Yes
2 Clear Contents
3 Cell » jenses
4 2 Undo n
Z & cut Ctrl+X —— —
£ B3 Copy Ctrl+C
9 &r C 1.00 1.00 $0.00
10 Easte sV 1.0 1.00 $0.00
1 Format Cells o | & cel Ctl+1 1.00 $0.00
12 Insert » Column (] 1.00 $0.00
13 Delete »|  Row »p 1.00 $0.00
i Sheet Properties Borders
LS iteria Vi #  Back Colour »
o B Criteria View Ctrl+Q IA— |‘D 0o DDD O0O0OoOOO0@E o OO
Mode » | & Fore Colour »

L & Print $ Currency Format OO O ODOODOO OO E R E @
19 Formula » | % Percent Format
20 - OO E B BEEO0OOONF N B FE N N ERN
= 3 Comma Format
2 %68 Increase Decimals ] HE B EED N EEENNN®N
23 3% Decrease Decimals

] - H B H E E B B E N N BB DN EHN
24 Run this report each month, changing the dates.

e Right-click in Row 24

e From the dropdown menu:
o Select Format Cells
o Select Back Color
o Select Grey
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File Edit View |Insert Format Cell Mode Tools Window Help
DR - FH S0 - BER |© & DBIE T | Tahom -975 - B I U [E=

2-A-0

$% 5 W%

@ EMPLOYEEEXPENSES -
EnployecExpenses {SheetTitle}
[ = |
A B c D E F G H 1
| 1 |Yes Yes Yes Yes
| 2 | Ace Union
EN Analysis of Employee Exp
| 4 | 2016 to 2017 Comparison
| 5 |
| 8 | 2016 2017
| 9 |811220 Car Depreciation Allowance 1.00 1.00 $0.00
| 10 /811230 Child Allowance 1.00 1.00 $0.00
| 11 811410 Area Travel Subsidy (House to Office Travel) 1.00 1.00 $0.00
| 12 816110 Medical Policy Premium 1.00 1.00 $0.00
| 13 817110 Tax Assi 1.00 1.00 $0.00
| 14 |
| 15 | 5.00 5.00
|17 |
| 18 |
19|
| 20 |
| 21 |
| 22 |
| 23 |
| 24 | Run this report each month, changing the dates.
— I

e Repeat those steps to color columns G, H, and | grey

File Edit View |Insert Format Cell Mode Tools Window Help
D“'ﬁﬂ‘ég"ﬂﬂjn“‘%ﬁ.'QZJTahoma -9.75-|nlg‘

A 8% W%

Filter To

@ EMPLOYEEEXPENSES =
EplayecEspenses {SheetTitle}
| o2 S
A | B c D E F G H 1

| 1 |Yes Yes Yes Yes
2 | Ace Union
EN lysis of Employee Exp
| 4 | 2016 to 2017 Comparison
| 5 |

8 2016 2017 |
| 9 811220 Car Depreciation Allowance 1.00 1.00 $0.00
| 10 1811230 Child Allowance 1.00 1.00 $0.00
| 11 811410 Area Travel Subsidy (House to Office Travel) 1.00 1.00 $0.00
| 12 816110 Medical Policy Premium 1.00 1.00 $0.00,
| 13 1817110 Tax Assi 1.00 1.00 $0.00
| 14 |
| 15 | 5.00 5.00
|17 |
| 18 |
19 |
| 20 |
| 21 |
| 22 |
| 23 |
| 24 | Run this report each month, changing the dates.

e Repeat also to make rows 25 through 36 grey
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Worksheet ] Document

{SheetTitle}

[ -l |

A | B

Yes
Ace Union
Analysis of Employee Expenses
2016 to 2017 Comparison

2016

2017

Yes

811220 Car Depreciation Allowance

| 10 |811230 Child Allowance

| 11 811410 Area Travel Subsidy (House to Office Travel)
| 12 |816110 Medical Policy Premium

| 13 1817110 Tax Assistance

1.00
1.00
1.00
1.00
1.00

1.00
1.00
1.00
1.00
1.00

24 Run this report each month, changing the dates.

¢ Open the Edit menu
o Select Format Tables

Q&A Executive Conditional Hiding
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Format Tables

zA‘? Code | Description | oK
Changes Yearly Changes -
Favorable Favorable or Unfavorable Cancel
Edit
New
Delete
e Click the = button
e Code HideRow
e Description Type in ‘Hide Row'
e Range From/To ‘Yes' To ‘Yes'

e Click the Hide Row option

.......................

[~ Hide Column
[~ Show Row
[~ Show Column

Q&A Executive Conditional Hiding
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Print
Export

Import

Add

Clear

W Format Table =
—Table
Code |HideRow
Description |Hide Row
From I To Display I &
> Yes Yes F—
| 2|
| 3
4 v
«| | »
—Range
From IYes To |Yes [~ Exdude
—Display
—Format — Apply to Worksheets
Font |~ Use this font
[~ Use this font colour v Primary
Background | |~ Use this background colour [v Drilldown
— Alert — Options [V Transactions
lert Name v Fide Fiow e
I LI [~ Hide Column 2| Expand Ik
|v Filter
[~ Store value |~ Show Row
[~ Show Column I Total Row

e Click Lbutton

Q&A Executive Conditional Hiding
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Format Tables

A

z? Code IDescription |

2

Changes Yearly Changes
Favorable Favorable or Unfavorable Cancel

HideRow Hide Row
Edit

New

Delete

e Click New again

e Code ‘HideZero’
e Description ‘Hide Zeros'
e Range From/To ‘0'To ‘0

Q&A Executive Conditional Hiding
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= Format Table = O
~Table Save
Code IHideZero
- Cancel
Description |Hide Zeros
From l To l Display l & Help
>> 0 0 F—
2 Print
3
4 - Export
«| | > Import
—Range L
From IO To |°| [~ Exdude
—Display Add

S

E-mail

—Format —Apply to Worksheets
Font | [~ Use this font )
|~ Use this font colour IV Primary
Background | I~ Use this background colour v Drildown
- _ Options [V Transactions
Alert Name [~ Hide Row /et
I LI [~ Hide Column 4! Expand
[~ Store value |~ ShowRow |
I show Column v Total Row
. Font
e Click the = button
Format
Font
Background

Q&A Executive Conditional Hiding
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Font X
Font: Font style: Size:
I Tahoma I Regular
LM Regular
empus Sans ITC Bold
i 10
erminal Obligue 1
Times New Roman Bold Obligue 12
Trebuchet MS 14
Tw Cen MT v L] v
— Effects —Sample
|~ Strikeout
[~ Underline
Color: Script:
| | |Western =]
Show more fonts |
OK I Cancel
e Color White

e Click I‘ button

Format Tables

27 Code |Description

Changes Yearly Changes
Favorable Favorable or Unfavorable
HideRow Hide Row

HideZero Hide Zeros

Q&A Executive Conditional Hiding
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Why change the cell background and font to white?
e Ifazeroamountis displayed in a cell, the font in that cell will be white.
e Because the background is white, the value in the cell will be invisible. It will
be effectively hidden, though the value is present in the cell.

e Check ‘Use this font’ and ‘Use this font color’ in the Format Tables interface

Format
Font I” Use this font

e Click L‘ button

New

e Clickthe = button

e Code ‘HideCol’

e Description ‘Hide Column’
e Range From/To ‘Yes' To ‘Yes'

¢ Check Hide Column

Options

[~ Hide Row

[~ Show Row

[~ Show Column

Q&A Executive Conditional Hiding

[~ Use this font colour
Background [~ Use this background colour
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Save

Cancel

Help

Print
Export
Import

Add

Clear

& Format Table -
~Table
Code IHideCoI
Description |Hide Column
From | To Display | -
>> |Yes Yes =
2
3
4 v
«| | L
—Range
From IYes To |[Yes [~ Exdude
—Display
~Format —Apply to Worksheets
Font | [~ Use this font )
[~ Use this font colour v Primary
Background | I™ Use this background colour v Drildown
- _ Options |V Transactions
Alert Name [~ Hide Row SR
|~ Store value =F=
 Show Column v Total Row

e Click L‘ button

Q&A Executive Conditional Hiding

E-mail

13



¢ SunPlus

Format Tables

£? Code | Description

Changes Yearly Changes
Favorable Favorable or Unfavorable
HideRow Hide Row

Cancel

HideZero Hide Zeros =
HideCol Hide Column =

New

Delete

£

e Click |

Attach Format Tables to appropriate worksheet cells.

Remember: Format Tables are available for the whole worksheet, but can be
attached to individual cells.

Double click in cell E1

O

Select HideCol Format Table

Q&A Executive Conditional Hiding
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Cell
LiLUE |cel ~ = E1
Cell Formula I
Cell Caption
Yes
—Format —Format Table
(¢ Text
" Number |HideCol ~| .. I
(" Currency
(" Percent Driver Value
" Date [=sEs1 |
" Time Yes
Help oK Cancel

At run time, the Format Table will check to see whether there is a Yes value in cell E1.
If there is, column E will be hidden.

e Type ‘Yes' into cells Gl and H1

Q&A Executive Conditional Hiding
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Worksheet I Document |

e Attach HideCol Format Table to cells Al, F1, G1, and H1
e Clickincell 124

e Attach HideRow Format Table to cell 124

e Attached HideRow Format Table to cell I
e Type ‘Yes'into cell I2

Worksheet I Document I

{SheetTitle}
’ I H1 L] IYes
A | B c D

| 1 |Yes Yes Yes Yes Yes| Yes
2 | Ace Union

3 Analysis of Employee Expenses
4 | 2016 to 2017 Comparison
5 |
8 | 2016 2017
9 1811220 Car Depreciation Allowance 1.00 1.00 $0.00
10 /811230 Child Allowance 1.00 1.00 $0.00
| 11 811410 Area Travel Subsidy (House to Office Travel) 1.00 1.00 $0.00
| 12 |816110 Medical Policy Premium 1.00 1.00 $0.00
13 817110 Tax Assistance 1.00 1.00 $0.00

14
| 15 | 5.00 5.00

17

18 e

19
20 |
21 |
22 |

23

24 Run this report each month. chanaina the dates.

Q&A Executive Conditional Hiding

{SheetTitle}
[ =
A | B c D

| 1 |Yes Yes Yes Yes Yes Yes
| 2 | Ace Union Yes

3 Analysis of Employee Expenses
4 | 2016 to 2017 Comparison
5 |
8 | 2016 2017
| 9 811220 Car Depreciation Allowance 1.00 1.00 $0.00
| 10 |811230 Child Allowance 1.00 1.00 $0.00
| 11 811410 Avrea Travel Subsidy (House to Office Travel) 1.00 1.00 $0.00
| 12 |816110 Medical Policy Premium 1.00 1.00 $0.00
| 13 817110 Tax Assistance 1.00 1.00 $0.00
14 |
| 15 | 5.00 5.00

17

18

19

20
21 |
22 |
| 23 |
| 24 | Run this report each month, changing the dates.

25
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e Click on cell

12

e Attach Format Table HideCol
e Extract the report

File View Output Mode Tools
DB - FH S0 - @MEE

i WodsheetIDocu'nentl

@ EMPLOYEEEXPENSES
EmployeeExpenses
% Name

Accounting
Arlington District
Children's Ministy
Communication
Congressional D
Education
Executive Secre
Family Ministries
General Functior

Window Help

|5 T

tmE@vHE .

Ace Union

Analysis of Employee Expenses

2016 to 2017 Comparison

2016

2017

Car Depreciation Allowance

4,142.46

1,199,001.64

Child Allowance

4,142.46

1,199,001.64

Area Travel Subsidy (House to Office Travel)

General Instituti
Georgetown Dis!
Health Ministry
In-House Opera
Ministerial Assog
Oxon Hill District
Potomac River C
Presidential
Public Affairs &
Publishing
Sabbath School
Secretarial Servi
Stewardship/Tru
Tidal Basin Distri
Transportation
Treasurer
Treasury

Vice President
Women's Ministri
Youth

Blank

[ EmployeeExpenses

[T T T

4,142.46

1,199,001.64

Medical Policy Premium

4,142.46

1,199,001.64

Tax Assistance

4,142.46

1,199,001.64

20,712.30

5,995,008.20

B4 Accnuntinn Perind

To hide zeroes that s how up among account figures in. columns C and D:

e Starting in row 9, double-click cell C9
e Gotothe Option tab
e Attach Format Table HideZero

Q&A Executive Conditional Hiding
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Summary Link

Data Type ISummary Link
Definiton Options I

Description

Recalculation Order
IDefauIt ;l

—Fixed Extraction

[~ Primary

[~ Breakout
[~ Drilldown
[~ Transactions
|~ Expand

—Format Table

IHideZero LI _l

Driver Value

[~scso J

1

—Cell Extract
I~ Locked

(o]

e Click II

Help

Cancel

e Attach the HideZero Format Table to cells C10 through D13

e Extract the Drill Path

Q&A Executive Conditional Hiding
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File View QOutput Mode Tools
DR -*FH S0- BYEE

.

4

EmployeeExpenses
% Name

Accounting
Arlington District
Children's Minists
Communication
Congressional D)|
Education
Executive Secre|
Family Ministries|
= =
General Instituti
Georgetown Dis
Health Ministry
In-House Opera|
Ministerial Assod
Oxon Hill District
Potomac River O
Presidential
Public Affairs &
Publishing

Window Help

£ Worksheet | Document |

ES%

BEYEE .

General Function Services

Sabbath School

B © D
2 |Ace Union
3 |Analysis of Employee Expenses
4 2016 to 2017 Comparison
5 |General Function Services
8 2016 2017
9 |Car Depreciation Allowance -502,125.00
10 | Child Allowance -502,125.00
11 |Area Travel Subsidy (House to Office Travel) -502,125.00
12 |Medical Policy Premium -502,125.00
13 Tax Assistance -502,125.00
14
15 0.00 -2,510,625.00
17
18
19
20
21
22
23

Notice that cells CO9 through C13 are apparently blank. This is because the Hide Zeros
formatting is working.

Export Format Tables

The Format Tables can be exported and imported into other worksheets.

Open the Edit menu
Select Format Tables

Q&A Executive Conditional Hiding
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Format Tables

I | 22 code | Description
Changes Yearly Changes
Favorable Favorable or Unfavorable
HideRow Hide Row
HideZero Hide Zeros
HideCol Hide Column
£

e Click the et button

Q&A Executive Conditional Hiding

Cancel
Edit

New

Delete
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H Format Table

Help

—Table
Code Ichanges
Description |vearly Changes
From | To | Displa o
>> -20000000 0 F—
2 0 20000000 F
3
4 hd
«| | »
—Range
From |-2ooooooo To |0 [~ Exdude
—Display

~Format —Apply to Worksheets
Eont [\7 Use this font
[¥ Use this font colour v Primary
Background | [V Use this background colour [V Drildown
— Alert —Options |V Transactions
Alert Name [~ Hide Row |V Breakout
I LI [~ Hide Column V]| Expand
[~ Store value [~ ShowRow V] Fiter
[~ Show Column I Total Row

e Clickthe &button

Print
Export

Import

Add
Clear

E-mail

Then use the LI button to attach the Format Table to the next

worksheet.

Q&A Executive Conditional Hiding
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